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Prise en main rapide
de Photoshop CS

Conventions utilisees dans la suite du document :
M : XX =2 yy = zz = séquence de commandes déclanchées a partir de la barre des menus
I © XX =2 yy =2 zz = séquence de commandes déclanchée a partir des icones de la fenétre graphique
Commentaire : commentaire sur une commande
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Trois exemples de retouche d’image (1/3)

http://www.webwhirlers.com/portfolio.html

Retouche netteté et luminosité ; détourage ; reparation parties abimees ; élimination grain
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Trois exemples de retouche d’image (2/3)

http://www.webwhirlers.com/portfolio.html

Retouches tonales et de netteté ; correction « yeux rouges » : élimination objet non désiré

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS



Page 4

Trois exemples de retouche d’image (3/3)

http://www.webwhirlers.com/portfolio.html

Détourage, élimination/remplacement, recadrage ; renforcement netteté
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Chaine de traitement de I’image numérigque avec Photoshop

(d’apreés Jeff Schewe)

Typical Digital Photo Workflow

2.Download 5.Digital
photos to retouching
computer .
- I ‘

“ ®o—@

L
» Photoshop

. g ag T ’
1. Digital » e, @ 6. Output 7. Archive
capture 4 N
@ -C
3.0Organize photos 4.Raw conversion
(apply keywords and of selects from an
create groups), and edit

choose selects
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Presentation de I’espace de travail
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Barre des menus

Barre d’options des outils
(paramétrage des outils) Explorateur d’images
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Palette outils
(voir page suivante)

Palettes

 Navigateur (déplacement dans I’image)/infos
(colorimétriques et geomeétrigues)/histogramme
 Couleurs/nuancier/style (sélection couleurs
premier plan et arriere plan)

* Historique/scripts/outils prédefinis

» Calques/couches/tracés




Phoptoshop

Couleur avant-plan /
arriere plan (D/X)

Mode standard /
masque (Q)

Affichage plein écran /
avec/sans menu) (F)

Photoshop <> ImageReady

ImageReady @ -

L_es outils - version Photoshop CS2 (1/8)

) Outils de sélection

=

B _: Rectangle de sélection (M)

P

i._? Hlipse de sélection (M)

Rectangle de sélection
1 colenne (M)

co=

=== Rectangle de sélection
1 rangée (M)

mh: Déplacement (V)
m§5" Lasso (L)

‘élf] Lasso polygonal (L)
‘@ Lasso magnétique (L)

m %, Baguette magique (W)

(B) Recadrage et tranche
Ry Recadrage (C)

1. Tranche (K)
®# Sélection de tranche

@ Outils de retouche

lf Correcteur de tons directs (J}
.? Correcteur (J)

i Piece ()

e il rouge (J)

s Tampon de duplication (5)
3 Tampon de motif (5)

m 5 Gomme (E)
%7 Gomme d'arriére-plan (E)
¥ Gomme magique (E)

] (5 Goutte d’eau (R)
A Nettets iR)
s Doigt (R)

m ® Densité- (0)
€2 Densité +(0)
= Eponge (O)

() Outils de dessin

® # Pinceau (B)
&# Crayon (B)
=3# Remplacement de
couleur (B)
m 5% Forme d'historique (Y)
g Forme d'historigue
artistique ()
® M Dégradé (G)
& Pot de peinture (G)

(3 Outils de dessin et de
texte

B &k Sélection de tracé (A)
Sélection directe (A)

Plume (P)
" Plume libre (P)
Ajout de point
d'ancrage (P)
Suppression de point
d'ancrage (P)

Conversion de point
d'ancrage (P)

7

® T Texte horizontal (T)
I'T Texte vertical (T)

.....

(T}

B[] Rectangle (U)
(J Rectangle arrondi (U)
O Ellipse (U)
@ Polygone (U)
™\ Trait (U)
&F Forme personnalisée (U)
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(@ Outils d’annotation, de
mesure et de navigation

L] @ Annotations (N}
&ld) Annotation audio (N)

m _# pipette (I)
J?;’# Echantillonnage de couleur (1)
& Mesure ()

® ") Main (H)
mQ Zoom (Z)

@ Outils ImageReady

u @; Carte-image rectangulaire (P)
';IF’, Carte-image circulaire (P)
% Carte-image polygonale (P)

m %l Sélection de carte-image (J)

m ] Onglet (R)
3 Pastille (R)

[ @ Afficher/Masquer les
carte-images (A)

m [ Afficher/Masquer les
tranches (Q)

m J, Apergudu document (Y)

n Apercu dans un navigateur
(emd+option+P)

B Qutil par défaut  * Raccourcis clavier entre parenthéses
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e Outils de sélection Les outils (2/8)

r

Les outils de Selection L'outil Déplacement permet Les outils de Lasso L'outil Baguette magique
permettent de tracer des de déplacer des sélections, permettent d'effectuer des  permet de sélectionner des

rectangles et des ellipses de des calques et des reperes sélections de forme libre, zones de couleur identique
sélection, ainsi que de sélec- polygonales (aux bords
tionner une seule rangée ou droits) et magnétiques

une seule colonne

@ Outils de recadrage et de tranche

L'outil Recadrage permet  L'outil Tranche permet de L'outil Sélection de tranche
de recadrer des images créer des tranches permet de sélectionner des
tranches D. Bounie, Polytech'Lille - IAAL, Prise en main rapide de Photoshop CS



e Outils de retouche

L'outil Correcteur de tons
directs permet de sup-
primer certaines imperfec-
tions et objets

L'outil Tampon de dupli-
cation permet de peindre en
utilisant I'échantillon préle-
V€ sur une image

L_es outils (3/8)

L'outil Correcteur corrige
les imperfections d'une
image en appliquant un
échantillon ou un motif

L'outil Tampon de motif
permet de peindre en uti-
lisant une portion d'image
comme motif
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{3

L'outil Piece corrige les L'outil Oeil rouge permet de
imperfections d'une portion  supprimer le reflet rouge
d'image en appliquant un provoqué par un flash
échantillon ou un motif

&

&%

L'outil Gomme efface des L'outil Gomme d'arriére-
pixels et annule les modifi-  plan permet de rendre une
cations effectuées sur zone transparente  par
I'image depuis le dernier glissement de la souris

enregistrement

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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e Outils de retouche (suite) Les outils (4/8)

a0

L’outil Gomme magique L’outil Goutte d’eau L’outil Netteté permet L’outil Doigt permet
efface les zones de couleurs permet de rendre flous les  d’accentuer la netteté des  d’étaler des couleurs sur
en aplat et les rend transpa-  contours nets d’une image contours d’une image une image

rentes d’un seul clic

N
=

L’outil Densité- permet L’outil Densité+ permet L’outil Eponge permet de

d’éclaircir certaines zones d’obscurcir certaines zones modifier la saturation des
de I’image de I’image couleurs d’une zone de

I’image

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Q Outils de peinture Les outils (5/8)

~N—
-

L’outil

Pinceau permet

d’appliquer une couleur
par touches successives

L’outil Forme d’historique
artistique applique des
touches de peinture repro-
duisant différents styles de
peinture, a partir d’un état
ou d’un instantané sélec-
tionné

/%4

i

L’outil Crayon permet de
dessiner des tracés aux
bords nets

Les outils de Dégradeé
permettent de créer des
dégradés ou des transi-
tions linéaires, circulaires,
inclinées, réfléchies et en
forme de losange entre les
couleurs

L’outil Remplacement
de couleur remplace une
couleur sélectionnée par
une autre couleur

L’outil Pot de peinture
permet d’appliquer la
couleur de premier plan a
des zones de méme
couleur

L’outil Forme d’historique
permet de peindre une copie
de I’état ou de I’instantané
sélectionnés dans la fenétre
de I’image

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS



e Outils de dessin et de texte

Les outils de Sélection de
tracé permettent de sélec-
tionner des formes ou des
segments et d’afficher leurs
points d’enrage, lignes direc-
trices et points directeurs

Les outils de Forme et
I’outil Trait permettent de
dessiner des formes et de
tracer des lignes dans un
calque simple comme dans
un calque de forme

Pasta

T

Les outils de Texte
permettent de saisir du
texte dans ne image

\_ 4
ey

&

L’outil Forme personnali-
sée permet d’appliquer des
formes personnalisees a
partir d’une liste

L_es outils (6/8)

R
w1y

i
L

Les outils de Masque de
texte permettent de créer
une sélection épousant la
forme du texte
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A |

Les outils de Plume
permettent de réaliser des
tracés aux contours lisses

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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L_es outils (7/8)

G Outils d’annotation, de mesure et de navigation

al

N\
J
Les outils d’annotations L outil Pipette permet de  L’outil Mesure permet de L’outil Main permet de
permettent de joindre des prélever les couleurs d’une  mesurer les distances, les déplacer une image a
notes et des commentaires image positions et les angles I’intérieur de la fenétre

sonores a une image

Q

L’outil  Zoom  permet
d’agrandir et de réduire
I’affichage d’une image

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS



e Outils propres a ImageReady

Les outils de cartes-images
permettent de delimiter des
zones de carte-image dans
une image

L'outil Afficher/Masquer
les tranches permet d'affi-
cher et de masquer les
tranches d'une image

L'outil Sélection de carte-
Image permet de sélection-
ner des cartes-images

EVENTS
¥

&

L'outil Apercu du docu-
ment affiche un apercu des
effets de transformation par
souris directement dans
ImageReady

L_es outils (8/8)

L'outil Onglet dessine un
rectangle aux angles supé-
rieurs arrondis

L'outil Pastille dessine un
rectangle  aux  angles
arrondis

L'outil Apercu dans [navi-
gateur par défaut] affiche
un apercu des animations
dans un navigateur Web
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L'outil Afficher/Masquer
les cartes-images permet
d'afficher et de masquer
les cartes-images

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Personnalisation de Photoshop

 Choisir I’espace colorimétrique de travail
M : Edition - Couleurs - paramétrage

« Paramétrer Photoshop
M : Edition - Préférences - Général

—> Gestion des fichiers
—> Affichage et pointeurs
—> Transparence et couleurs non imprimables
—> Unités et regles
—> Reperes, grille et tranche
—> Modules externes et disques de travail
- Mémoire et mémoire cache
—> Explorateur de fichiers

* Personnaliser la présentation graphique (nombre/position palettes)
M : Fenétres - (sélection/déselection des palettes retenues)
| : Palettes : double click bandeau et/ou déplacement

 Enregistrement espace de travail
M : Fenétre - Espace de travail - Enregistrer I’espace de travail - nom

 Personnaliser les outils
| : sélection outil - barre d’options - bouton + -> nouvel outil prédefini - nom

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Démarrage session de travail

« Commencer par I’ouverture d’un nouveau fichier ou d’un fichier existant :
- nouveau fichier :
M : Fichier - Nouveau
préciser :
- la taille de I’image et la couleur d’arriere plan
- I’espace colorimétrique (mode et résolution)
- éventuellement le profil ICC
- fichier existant :
M : Fichier = Ouvrir (sélectionner un fichier de type : « tous les formats »)

 Importation dans Photoshop d’une photo a retoucher
1. ouvrir un nouveau fichier (peu importe sa taille)
2. coller dans I’image active, une copie de la photo a traiter : une nouvelle fenétre
graphique s’ouvre, a la taille de la photo, et celle-ci est placée dans le calque d’arriere
plan

ou

1. ouvrir directement la photo a partir de I’explorateur de photos de Photoshop : une
nouvelle image active s’ouvre, a la taille de la photo, et celle-ci est placée dans le calque
d’arriere plan

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Quelgues principes généraux

* En général, chague commande est modulée par des options parametrables, accessibles :
— soit a partir de la barre des options d’outils
— soit a partir d’un menu contextuel (clic droit souris)

 Notion de calque : création, ordre d’empilement, masquage/démasquage, opacite, verrouillage
— calque de remplissage (transparent ou colore)
— calque de réglage : couche d’informations de modification n’affectant pas I’image
originale
— toujours commencer par faire une copie de I’image originale (calque d’arriere-plan)

 Notion de masques :
— masques de fusion
— masques de texte, masques de forme (masques vectoriels)

» Notion de couches : RVB, R, V, B

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Premieres operations : traitement global de I’image (1/2)
Modifications géométriques

» Redimensionnement (taille et résolution) :
M : Image —>Taille de I’'image

» Recadrage/redressement :
— rognage :
| : outil rognage & = tracé zone rognage —> clic droit : recadrer ou double-click
— rotation fixe :
M : Image - Rotation zone de travail - 180°, 90°, symétrie
— rotation paramétree :
1. calcul de I’angle de rotation :
I : outil mesurel /> trace ligne repere - barre d’options d’outil : lecture angle
2. rotation :
M : Image - Rotation zone de travail - Paramétrée - valeur de I’angle

« Correction distorsions (perspectives) :
1. M : Selection = Tout sélectionner
2. M : Edition = Transformation = Perspectives = barre d’options d’outils : validation
par bouton  ou : Edition = Transformation manuelle = Shift-Ctrl-Alt maintenus +
déplacement d’une ancre de coin -2 Validation)

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Premieres operations : traitement global de I’image (1/2)
Modifications colorimétriques

» Niveaux (histogramme des niveaux de gris)
M : Image > Reéglages - Niveaux - reglage niveaux min. (Noir), max. (Blanc),
moyen, point blanc, point noir

» Courbes (modification tonale)
M . Image = Reéglages - Courbes - réglage point noir, point blanc, points
intermédiaires

 Balance des couleurs (teintes et tons)
M : Image - Reéglages = Balance des couleurs = réglage Balance des couleurs et
Balance des tons

 Luminosité/contraste
M : Image - Reéglages = Luminosité/Contraste - réeglage Luminosite et Contraste

e Teinte/saturation
M . Image = Réglages - Teinte/Saturation - modification Global ou couleurs
individuelles ; réglage Teinte, Saturation, Luminosité

 Toutes ces opérations peuvent également étre effectuées sur des selections ou des
calques de réglage (demo calque de reglage)

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Opérations plus elaborées : traitement local de I’image (1/2)
Outils de sélection

 Sélection par formes predeéfinies (crée un masque de fusion vectoriel) :
— Rectangle de sélection
— Ellipse de sélection
— Addition/sélection/intersection de sélections
| : Outils > Forme de selection - Barre d’options d’outils : @ou = ou

o Sélection par trace libre :

— Lasso :
e Lasso simple
* Lasso polygonal (segments de droites)
o Lasso simple < lasso polygonal (tracé avec touche « alt » enfoncée/relachee)
 Lasso magnétique (suivi de contour)

— plume (tracés courbes)

— baguette magique (reconnaissance pixels de couleurs +/- identiques)

e Inversion de sélection :
M : Sélection = Inversion de sélection

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Opérations plus elaborées : traitement local de I’image (2/2)
Masques de fusion

- La zone d’opacite (zone masquée) est celle ou s’appliquera le traitement ultérieur
- La zone de transparence (zone démasquee) est celle ou ne s’appliquera pas le traitement

1. Sélectionner un calque :
| : Palette des clagues = clic sur vignette d’un calque (calque se met en surbrillance)

2. Lui ajouter un masque de fusion :
| : palette des claques = clic sur bouton =i(ajoute un masque de fusion)

3. Verifier couleurs de premier plan et d’arriere plan (noir/blanc)
- peindre en noir rajoute de I’opacité
- peindre en blanc rajoute de la transparence

4. Dessiner le masque :
- pour ajouter au masque : peindre avec I’outil pinceau (si premier plan = noir)
- pour retrancher au masque : gommer avec la gomme (si arriere plan = blanc)
6. Repasser en mode Standard au lieu du mode Calque et vérifier la forme du masque

7. Appliquer le traitement voulu a la zone de masque (M : Image - traitement choisi)

Démo masque de fusion

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Opérations plus complexes

o Filtres (sur intégralité ou sélection) ; Plugs-in
M : Filtres = ...

 Traitements par lots (taches ou ségquences de taches réepetées sur plusieurs images)
M : Fichiers - Automatisation - Traitement par lots - sélection script - paramétrage

 Sauvegarde sous forme fichier pdf
M : Fichiers > Automatisation - Présentation PDF - paramétrage mono- ou multipage

 Transformation fichier PDF - fichier Photoshop
M : Fichiers = Automatisation - Conversion multipage PDF - PSD - paramétrage

 Galerie photos web (diaporamas)
M : Fichiers - Automatisation - Galerie Web Photo - paramétrage

* Planche photo (collection vignettes)
M : Fichiers - Automatisation - Planche Contact Il - paramétrage

 Panorama (collage bout a bout de photos panoramiques décalées)
M : Fichiers - Automatisation - MergePhoto - paramétrage

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Techniques avanceées : liens de sites en francais
(tutoriels, plugs-in)

e La référence Adobe
http://www.adobe.fr/products/tips/photoshop.html
http://studio.adobe.com/fr/tips/main.jsp puis recherche sur Photoshop
* Liste de tutoriels
http://www.tutoriels.com/ et taper Photoshop dans la case du moteur de recherche
http://www.tutorials-fr.com/ et taper Photoshop dans la case du moteur de recherche
http://search.nascimpact.com/ et taper Photoshop dans la case du moteur de recherche
» AbsolutPhoto
http://www.absolut-photo.com/tutoriels/photoshop.php

» Octopussy
http://www.octopussy-world.com/tutoriaux.htm
» Toshop
http://toshop.free.fr/index.htm
* Psill.net
http://www.psill.net/1_intro.htm
» Over-Blog
http://photoshop.over-blog.com/liste-article-blog.php
« Autres

http://vincentlucphoto.com/tutoriaux_photoshop.html
http://www.photoshopmagazine.com/dossiers.php
http://www.photoshopmagazine.com/tutlist.php
http://www.teknopole.com/tuto/v2/index.php?id=tutz (graphisme)

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Techniques avanceées : liens de sites en anglais

» Adobe Photoshop : la page des ressources
http://www.adobe.com/support/training.html

* Planet Photoshop
http://www.planetphotoshop.com/tutorials.html

» Absolute Cross
http://www.absolutecross.com/tutorials/photoshop/

 Laurie McCanna
http://www.mccannas.com/pshop/photosh0.htm

D. Bounie, Polytech'Lille — IAAL, Prise en main rapide de Photoshop CS
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Didacticiels a votre service (1/3)

4 séries de didacticiels sont a votre disposition en libre service sur les machines multimédia de la salle B005
(compte « étudiants » ; puis répertoire « démos »)

Démol (cliquer sur HSRNpc.exe)

(S) :

» Changement de couleur
» Changement de tétes

» Correction de couleur

e Créer un détourage (S)
« Eclaircir et assombrir

» Effet Sabatier

* Jouer avec la lumiére

* Les calques de réglage (S)
* Les masques de fusion
* Recadrage et netteté

* Séparation tonale

* Soignez vos arrieres

* Sous-exposition

* Supprimez les fonds

» Tamisez

* Verticales convergentes

attention, nécessite des enceintes ou écouteurs

Démo 2 (cliquer sur HSRN.exe)

® Astuces sur Photoshop
1.modification couleurs
2.Corriger les distorsions
3.Incliner une photo
4 Effets de texte

 Calques de densité

 Coloriez avec la plume

 Coloriez un portrait

* Dynamisez un logo

o Effet de lumiere

o Effets en chambre noire

o Effets sur les bords

* Le rendu fait main

* Lignes et courbes

» Maitrisez la couche alpha

» Recadrage

 Reflexions ondulantes

 Traitement croisé

 Vous voulez encadrer
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Didacticiels a votre service (2/3)

Démo 3 (cliquer sur START.EXE, puis menu « CD

contents »)
Les fichiers d’exemples pour les exercices du livre « Photoshop 6 » chez
Campus Press
* Ch 02 - Getting Your Feet Wet: Your First Masterpiece
* Ch 03 - Understanding Photoshop's New Color Management System
* Ch 04 - Optimizing your Workspace: Photoshop Preferences
* Ch 06 - Acquiring Photoshop Images
» Ch 08 - Enhancing Productivity: Automation and Other Cool Tools
* Ch 09 - Selecting in Photoshop: Ah, the Many Ways to Select Stuff
» Ch 10 - Building Images Layer by Layer
» Ch 11 - Painting with Pen and Path Selection Tools
* Ch 12 - Introducing Shapes: Someplace Between Paths and Selections
» Ch 13 - Creating Special Effects with Type
* Ch 14 - Color Correcting and Exposure: Basic Image Improvement
* Ch 15 - Repairing an Heirloom Photo
* Ch 16 - Finding (and Fixing) Mistakes in Pictures
* Ch 17 - Using the Clone Stamp Tool, Image Selection and Distortion
» Ch 18 - Making the Impossible Look Plausible: Surrealistic Photoshop
* Ch 19 - Saving the Day with Photoshop and a Scanner
* Ch 20 - Mixing 3D Graphics with Photographs
» Ch 21 - Using a Boatload of Native Photoshop Filters
» Ch 22 - Working with Type
* Ch 23 - Optimizing Images for the Web
* Ch 24 - Creating Image Maps and Instant Web Graphics
» Ch 25 - Creating Rollovers and Animations

Démo 4 : « Sélections et masques » (cliquer

sur VIDEO_TS.IFO)
Attention : nécessite des enceintes ou écouteurs

* Quelques trucs pour la sélection

* Créer une sélection a partir de I’intérieur
» Creéer une sélection avec les touches Alt et Shift
» Styles de selection

* Contours progressif

* Qutil Lasso magnétique

* Options « Pixels contigus » et « Utiliser tous les
calques » de I’outil baguette magique

* Option Plage de couleurs

» Modifier une sélection

* Transformer une selection

* Mémoriser une selection

* Outil « Baguette magique »

* Les 3 modes de gomme

* Outil Gomme d’arriére plan

* Filtre d’extraction

e Qutil Plume

* Fonctionnement de I’option Masque

» Création de masques

» Masques de calques

 Couche alpha
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Didacticiels a votre service (3/3)

Démo 5 :

Attention : nécessite des enceintes ou écouteurs
Animations multimédia tirées du livre « Photoshop CS2 pour les Photographes » chez Eyrolles
» 01_imagewarping.mov : lens correction and image warping
 02_vanishingpoint.mov : vanishing point
» 03_merge.mov : merging exposures
* 04_maskinghair.mov : masking hair
» 05_reduceimagenoise.mov : reducing image noise
 06_crossprocessing.mov : cross processing techniques
» 07_monotocolor.mov : black and white from color
 08_importcamerafiles.mov : importing camera files
* 09 _newrawcontrols.mov : new Adobe Camera Raw Controls
10 calibration.mov : calibrating Camera Raw

e path_draw.mov
* rgh.mov
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